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1. Standard Operation Procedure – Dead-end Ultrafiltration for the Detection of 

Cyclospora cayetanensis from Agricultural Water 
 
Procedures for Dead-end Ultrafiltration and Detection of Cyclospora cayetanensis from 
Ultrafilter pellets. 
This analytical procedure provides steps for isolation of C. cayetanensis oocysts from agricultural 
water samples by dead-end ultrafiltration and subsequent DNA template preparation from ultrafilter 
pellets. We have divided this protocol in two parts. Part I covers the dead-end ultrafiltration 
protocol, and Part II covers the recovery and detection of C. cayetanensis from the ultrafilters.  
 

 Dead-end Ultrafiltration 
Equipment and Supplies 
A. Geopump™ Peristaltic Pump Series II Package (includes easy-load II pump 

head and a portable battery), Geotech, Cat No. 91352123. 
B. Pump Assembly (or equivalent assembly): 

i. DIN adapter (for End Port), Molded Products, Cat. No. MPC855 
NS.375. 

ii. Blood port (End) cap, Molded Products, Cat. No. MPC-40. 
iii. Dialysate Port (Side) cap, Molded Products, Cat. No. MPC-60D. 
iv. L/S 36 tubing (9.7mm ID), Cole Parmer, Cat. No. EW-96410-36 or 

EW-06434-36.   
v. SNP-8 hose clamps (for DIN adapter), Cole Parmer, Cat. No. EW-

06832-08. 
vi. SNP-12 hose clamps (for side port), Cole Parmer, Cat. No. EW-

06832-12 (optional). 
C. Hollow fiber ultrafilter Nipro Elisio 25H. 
D. Turbidity Meter (optional) with a resolution of 0.01 NTU, a range up to at 

least 200 NTU, and compliant with EPA 180.1 method or ISO 7027 standard. 
E. 500 mL plastic bottles for turbidity measurement samples and sodium 

thiosulfate solution. 
F. Flow meter.  
G. Sterilized scissors (required to cut tubing). 
H. Pliers (to close the hose clamps). 
I. Autoclavable biohazard waste bags. 
J. Appropriate Personal protective equipment (PPE) such as hand sanitizer, 

gloves, protective eyewear, and lab coats as needed.  
 
Reagents 
A. Sodium thiosulfate, Fisher Cat. No S446 (Only needed for chlorinated water), 

or equivalent. 
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Ultrafiltration Procedure for the Detection of Cyclospora cayetanensis 

 Note: The filtration protocol can be executed in the field.  
 

Ultrafiltration Setup 

 
Figure 1.Diagram of the filtration system. 

 
Ultrafiltration Protocol  
Note 1: If the water to be collected contains free chlorine or chlorination is suspected, 
immediately after the filtration process, treat the filter with a 1% sodium thiosulfate 
solution following the procedure described in section A.iii.  
 
Note 2: Charge the pump batteries in advance according to the manufacturer’s 
instructions.   
 

i. Check turbidity of water 
a. Set aside a sample of approximately 500 mL for turbidity 

measurements in a 500 mL bottle. 
b. If a turbidity meter is not available, ship the collected sample 

together with the filter to the laboratory that will perform the 
analysis.  

c. If a turbidity meter is available, allow any debris to settle out 
of the water for approximately one minute and measure the 
turbidity according to the manufacturer’s instructions. (Do not 
transfer the settled debris into the turbidimeter). 

d. If turbidity is higher than 40 Nephelometric Turbidity Units 
(NTU), or a turbidimeter is not available in the field, monitor 
the effluent flow rate during the filtration. If the rate decreases 
abruptly, stop the filtration and record the total volume of 
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water that was filtered. If the turbidity is less than 40 NTU, the 
filter should not clog before filtering a 10 L sample.  

ii. Ultrafiltration Procedure  
a. Select the sampling locations and determine the number of 

filters to be used. This protocol was optimized for filtration of 
10 L water with each filter. The filters cannot be used under 
freezing conditions.  

b. Assemble the filtration system with one filter as shown in 
Figure 1, using the supplies and equipment listed above. 
Position the peristaltic pump on a flat surface or stand lift 
platform. Place the filter next to the pump. 

c. Label one end of the filter “A” and the other end “B”. 
d. Remove the end port cap from the “A” end of the filter.  
e. Screw in the DIN adapter to the “A” end port.  
f. Push the influent L/S 36 tubing onto the DIN adapter and 

secure with a SNP 8 tubing clamp. Use the pliers to secure the 
clamp in place if needed. Use the scissors to cut sufficient 
tubing to feed through the pump head and reach the water 
source.  

g. Remove the cap from the side port close to the “A” end. Push 
the Dialysate Port (side) cap onto the side port and secure with 
a SNP 12 tubing clamp. 

h. Remove the cap from the “B” end port. Screw in the blood 
port (end) cap to the “B” end of the filter opposite to the DIN 
adapter. 

i. Feed the influent tubing through the pump head and close the 
pump head using the lever. 

j. Remove the cap from the side port close to the “B” end. Push 
effluent L/S 36 tubing onto the open side port as shown above 
and secure with a SNP 12 tubing clamp. 

k. If a flow totalizer meter will be used to measure the volume of 
water filtered, screw a 3/4" GHT adapter onto each end, cut 
tubing attached to red side port and push tubing onto both sides 
of the meter (ensure directional flow of the meter is correct), 
no clamps are needed. 

l. Place the influent tubing into the body of water and ensure the 
end of the tubing will stay below the surface of the water and 
away from plant material or other large debris which may be 
present. Be cautious not to disturb the water significantly near 
the filtration site. 

m. Plug in the appropriate power cord into the outlet in the back 
of the pump and the other end of the power cord into the power 
source. The power source can be any external 12-18 V DC @ 
70 watts or 90-260 V AC 47-65 Hz. Place the battery in a place 
where it will not get wet. 

n. Determine the desired direction of flow and set the toggle 
switch for the flow direction. Ensure the speed dial is set to 
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zero before starting the pump.   
o. Turn the pump “ON” (the black filled circle), record the start 

time of filtration. 
p. Once pumping has begun, the speed dial can be adjusted to 

gradually increase the flow to the maximum speed setting. 
q. As soon a volume of 10 L is filtered, reduce the speed to the 

minimum and turn the pump “OFF”. Record the stop time of 
filtration.  

r. If the water is chlorinated or chlorination is suspected follow 
the instructions in item iii below to treat the ultrafilter with 1% 
sodium thiosulfate. If the water is not chlorinated, skip this 
step. 

s. Remove all tubing from the ultrafilter. Screw a blood port cap 
into the influent port on the “A” end. 

t. Place a Dialysate Port (side) cap on the side port of the “B” 
end where the tubing was removed. 

u. Influent tubing can be reused when collecting multiple subsets 
from the same sample. Influent tubing can be discarded in the 
biohazard bags after collecting each sample. Effluent tubing 
can be reused for subsequent samples. All tubing clamps and 
adapters that can be reused should be sterilized by autoclaving 
for future use. 

v. Each filter must be labelled with the following information: 
Location, sample name, sample collection date and time, 
turbidity (if available), the amount of water that was filtered, 
and contact information from the person collecting the sample. 
An arrow should be drawn on the filter to indicate the direction 
of the flow of water (see Figure 1). 

w. Place the filter in a cooler for transport to the laboratory. Use 
ice packs to keep the cooler cold if necessary for the 
target/suspected microbes collected. 

iii. Procedure to treat ultrafilters with 1% sodium thiosulfate solution 
when agricultural water is suspected to have been treated with 
chlorine. 
a. Fill a 500 mL bottle with non-chlorinated water and add 5 g 

sodium thiosulfate, shake to dissolve. 
b. Place the influent tubing into the 1% sodium thiosulfate 

solution immediately after the filtration process and pump the 
entire volume through the filter without pumping air into the 
ultrafilter. 
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 Recovery and Detection of Cyclospora cayetanensis from Ultrafilters 
 

Laboratory Facilities 
A. A laboratory bench for the ultrafilter backflushing and concentration 

procedures. 
B. A laboratory bench or hood for the DNA extraction procedure. 
C. Separate workstations for each step of the qPCR protocol to allow an efficient 

workflow and eliminate the potential for false positive results due to 
laboratory contamination. 

Equipment and Supplies 
A. Geopump™ Peristaltic Pump Series II Package (includes easy-load II pump 

head and batteries), Geotech, Cat No. 91352123. 
B. Turbidity Meter with a resolution of 0.01 NTU, a range up to at least 200 

NTU, and compliant with EPA 180.1 method or ISO 7027 standard. 
C. Pump Assembly (or equivalent assembly): 

i. DIN adapter (for End Port), Molded Products, Cat. No. MPC855 
NS.375. 

ii. Blood port (End) cap, Molded Products, Cat. No. MPC-40. 
iii. Dialysate Port (Side) cap, Molded Products, Cat. No. MPC-60D. 
iv. L/S 36 tubing (9.7mm ID), Cole Parmer, Cat. No. EW-96410-36 or 

EW-06434-36. 
v. SNP-12 hose clamps (for side port), Cole Parmer, Cat. No. EW-

06832-12. 
D. Laboratory lift stand for pump (optional). 
E. Laboratory ring stand and clamps to support filter during backflush procedure 
F. 1 L glass beaker for collecting backflushed sample or 1 L Nalgene bottles, 

Fisher, Cat. No. 02-893D (or equivalent). 
G. 500-mL Nalgene bottles, Fisher, Cat No. 02-893C (or equivalent). 
H. Centrifuge (or equivalent assembly) capable of spinning 15 mL and 50 mL 

conical tubes and 500 mL, 225 mL, or 175 mL centrifuge bottles at 4000 x g: 
i. Thermo Scientific™ Sorvall™ Legend™ XTR Centrifuge Package, 

Fisher, Cat. No.75-217-420. Package must include:  
a. Thermo Scientific™ Sorvall™ Legend™ TX-1000 high 

capacity rotor. 
b. 15 mL and 50 mL Conical Tube Adapters, set of 4. 

ii. 500 mL bottle adapters for TX-1000 Swinging Bucket Rotor, sold as 
set of 4, Fisher, Cat. No. 75007302. Not included in above centrifuge 
package, must be ordered separately.  

iii. 250/175 mL bottle adapters for TX-1000 Swinging Bucket Rotor, sold 
as set of 4, Fisher, Cat. No. 75005392 or Cat. No. 75007305 (higher 
capacity). Not included in above centrifuge package, must be ordered 
separately.  

I. Vacuum aspiration system (or equivalent assembly): 
i. Foxx Life Sciences, Vactrap™, PP (Autoclavable), 4 L, Red Bin, 

SKU: 305-4001-FLS. 
ii. Vacuum pump or house vacuum. 
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iii. Glass Pasteur pipettes or equivalent disposable plastic pipettes for 
vacuum aspiration of supernatants. 

J. Autoclavable Polypropylene Centrifuge Tubes, 500mL, Fisher, Cat. No. 07-
200-621 (or equivalent). If using 250/175 mL bottle adapters instead of 500 
mL bottle adaptor then purchase Autoclavable Polypropylene Centrifuge 
Tubes, 225 mL, Fisher, Cat. No. 05-538-61, or Autoclavable Polypropylene 
Centrifuge Tubes, 175 mLFisher, Cat No. 05-538-62 (or equivalent). 

K. Conical Sterile Polypropylene Centrifuge Tubes, 15 mL or 50 mL (preferred), 
Fisher, Cat. Nos. 339650 or 14-432-22 (or equivalent). 

L. FastPrep®-24 Instrument (bead beater), 5G (SKU 116005500) or Classic 
(SKU 116004500), MP Biomedicals. 

M. Benchtop microcentrifuge (24 tube). 
N. Heat block with core for 2.0 mL microcentrifuge tubes.  
O. Benchtop Vortex mixer.  
P. Eppendorf Repeater Repeating Pipette and assorted Combitips (optional). 
Q. Sterile DNase-free polypropylene microcentrifuge tubes, 1.5 mL 
R. Sterile DNase-free polypropylene microcentrifuge tubes, 2.0 mL 
S. 5.0 mL Tubes for Centrifugation (Eppendorf Tubes® with snap cap Biopur, 

Fisher, Cat. No. 14-282-303 or Argos TechnologiesTM Microcentrifuge tubes, 
Fisher, Cat. No. 03-391-276). 

T. Sterile applicator Sticks, Fisher, Cat. No. 22-029-641 (optional). 
U. Applied Biosystems 7500 Fast Real-Time PCR System with Software 

versions 1.4, 2.0, or 2.3 or newer, ThermoFisher Scientific. 
V. VWR Mini Centrifuge (or comparable), VWR, Cat. No. 76269-064. 
W. Applied Biosystems MicroAmp® Fast Optical 96-Well Reaction Plates, 0.1 

mL, and MicroAmp® Optical Adhesive Film, Cat Nos. 4346907 and 
4311971, (ThermoFisher Scientific) or equivalent. 

X. Benchtop centrifuge capable of spinning 96-Well reaction plates  
Y. Analytical Balance (0.01 g resolution). 
Z. Magnetic Stir Plate. 
AA. Teflon coated stir bar. 
BB. Digital laboratory timer. 
CC. Sterile scalpel or scissors (required to cut tubing). 
DD. Pliers (to close the hose clamps). 
EE. Pipet-Aid 
FF. 1 mL serological pipettes 
GG. 2 mL serological pipettes 
HH. 5 mL serological pipettes 
II. 10 mL serological pipettes 
JJ. Micropipettors 
KK. 2 µL aerosol resistant pipette tips with filter. 
LL. 20 µL aerosol resistant pipette tips with filter. 
MM. 200 µL aerosol resistant pipette tips with filter. 
NN. 1000 µL aerosol resistant pipette tips with filter. 
OO. Transfer pipettes 
PP. Appropriate personal protective equipment (PPE) such as hand sanitizer, 

protective eyewear, gloves and lab coats as needed. 
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Reagents 
A. Sodium polyphosphate (NaPP), Sigma, Cat. No. 305553-25G. 
B. Tween 80, Fisher, Cat. No. T164-500 mL 
C. Antifoam L-30 emulsion, Sigma, Cat. No. STS0100 
D. Dulbecco’s Phosphate Buffered Saline (PBS), no calcium, no magnesium, 

Thermo Fisher Scientific, Cat. No. 14190250, (or equivalent) 
E. FastDNA SPIN Kit for Soil, 50 preps, MP Biomedicals, Fisher, Cat. No. 

MP116560200 or FastDNA SPIN Kit for Soil, 100 preps, MP Biomedicals, 
Fisher, Cat. No. MP116560300 

F. QIAquick® PCR Purification Kit (50), Qiagen, Cat. No. 28104 or QIAquick® 
PCR Purification Kit (250), Qiagen, Cat. No. 28106 

G. 100% Ethanol 
H. 3 M Sodium Acetate Solution, pH 5.2, Fisher Scientific, Cat. No. FERR1181 
I. Sterile DNase-free TE buffer, pH 7.5, IDTE Cat. No. 11-01-02-02 (or 

equivalent such as Appendix 2)  
J. DNA AWAY Surface Decontaminant, Fisher, Cat. No. 21-236-28 OR 10% 

bleach 
K. Real-time PCR reagents  

i. PrimeTimeTM Gene Expression Master Mix (IDT) (Cat. No 1055770 (1 
x1 ml) or Cat No. 1055772 (1 x 5 ml). Separate tubes of reference dye 
(ROX) are included with the master mix and need to be added to the 
master mix as a low reference dye for Applied Biosystems 7500 Fast 
Real-Time PCR instruments following the manufacturer instructions 
before use 

ii. Sterile DNase-free TE buffer pH 7.5 (commercially prepared IDTE Cat. 
No. 11-01-02-02 or see Appendix 2) 

iii. Primers, 500 µM stock solution (See Table 1-2) 
iv. Probes, 100 µM stock solution (See Table 1-3) 
v. IAC Target (HMultra130-synIAC), working concentration 1E7 

copies/µL. See Reagent Ordering and Preparation Instructions.  
vi. Positive control (Mit1AA gblock), 5E2 copies/µL. See Reagent 

Ordering and Preparation Instructions 
vii. Negative control (Water, DNase-free) 

  



Standard Operation Procedure 
Dead-end Ultrafiltration for the Detection of Cyclospora cayetanensis from Agricultural Water 

   

9  

Procedures 
 
Note: The backflush and concentration protocols to prepare samples for DNA 
extraction can be executed for a set of up to four filters in a single day using one 
centrifuge and one analyst. 

 
Turbidity Measurement  
A. If an unfiltered water sample is provided for a turbidity measurement, use a 

turbidimeter to measure the turbidity according to the manufacturer’s 
instructions. The sample should be at room temperature before measuring 
turbidity. Measure the turbidity at any time before executing the backflush 
procedure. 

i. Allow any debris to settle out of the provided unfiltered water sample for 
approximately one minute and do not transfer the settled debris into the 
turbidimeter. 

ii. Record the turbidity of the water sample in Nephelometric Turbidity Units 
(NTU). 

 
Backflush - Recovery of Cyclospora cayetanensis from ultrafilters 
A. Preparation of Backflush solution (0.5% Tween 80/0.01% NaPP/0.001% 

Antifoam L-30). Note: the solution should be prepared freshly on the first day 
and stored at 4 °C for no more than 48 hours.  

i.            Make 10 mL 10% NaPP/1% Antifoam L-30 stock solution: 
a. Add 10 mL DI water to a 15 mL or 50 mL conical tube. 
b. Add 1 g NaPP and 100 µL Antifoam L-30 to the water. 
c. Vortex to dissolve the NaPP.  

ii.            For each ultrafilter to be processed, make 500 mL backflush solution: 
a. Add 500 mL DI water to a 500 mL or 1 L bottle. 
b. Add 500 µL of the 10% NaPP/1% Antifoam L-30 stock 

solution to the water. 
c. Add 2.5 mL of Tween 80 with a serological pipette.  
d. Stir with a sterile stir bar for at least 5 min to dissolve the 

Tween 80. 
 

Backflush Procedure  
i. Remove the selected filters from the refrigerator at least one hour 

prior to executing the backflush procedure. 
ii. Assemble the filtration system with one filter, as shown in Figure 2 or 

3 depending on how the pump is supported, using the supplies and 
equipment listed above: 
a. Position the peristaltic pump on a level surface or on a lift 

platform at least 20” above the bench surface. 
b. Clamp the filter on a ring stand and make certain the “B” end 

of the filter is on the top. 
c. Remove the side port cap from the “B” end of the filter. 
d. Push L/S 36 tubing onto the side port and secure with a SNP 

12 hose clamp. 
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e. Feed the tubing through a peristaltic pump and place the end of 
the tubing into the 500 mL of backflush solution. Close the 
pump head lever. 

f. Hold the “A” end port over a 1 L sterile bottle or beaker, and 
remove the end port cap.  

iii. Set the pump dial setting to zero and turn on the pump.  Slowly 
increase the flow rate by turning up the dial to a slow pumping rate.  If 
the pump has a digital display, the flow rate can be set at ~ 650 
mL/minute. 

iv.     Continue pumping until no backflush solution remains in the container 
or the tubing and the out flow from the ultrafilter has slowed to a 
trickle. Do not pump air into the filter for more than approximately 
10s. 

v.            Measure and record backflush volume or weight, if necessary.  
vi. Repeat the backflush procedure for the remaining filters of the set. 

vii. All DIN adapters, Blood port (End) caps, Dialysate Port (Side) caps 
and clamps can be autoclaved and reused.  

viii. Proceed to the concentration procedure.  
 

 
Figure 2. Backflush assembly. 
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Figure 3. Backflush assembly. 

Concentrating Cyclospora cayetanensis from Backflush Effluent 
A. Each filter yields approximately 600 mL of effluent. Divide the effluent 

collected from each filter into two 500 mL conical centrifuge bottles. 
Alternatively, four 175/225 mL conical centrifuge bottles can be used.  

B. Balance the conical bottles using sterile PBS and centrifuge at 4,000 x g for 
45 min with maximal acceleration and a brake setting of 6 (on a scale of 0-9) 
for deceleration.  

C. Carefully remove and discard all but ~25 mL of the supernatant from each 
centrifuge bottle using a glass Pasteur pipette connected to a vacuum aspirator 
or a 50 mL serological pipette. Using a vacuum aspiration system will be 
faster and more efficient than using a serological pipette. 

D. Re-suspend each pellet in the remaining supernatant by pipetting up/down and 
vortexing. Transfer approximately 25 mL aliquots of the re-suspended 
material from the two 500 mL centrifuge bottles to one 50 mL centrifuge tube 
(if the pellet is too large, we might split into two or more 50 mL centrifuge 
tubes). If using 175/225 mL bottles, transfer approximately 30 mL aliquots of 
the re-suspended material to four 50 mL centrifuge tubes. Alternatively, 13-15 
mL aliquots of the re-suspended material from four 175/225 mL centrifuge 
bottles can be transferred to multiple 15 mL centrifuge tubes.  Use a single 10 
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mL aliquot of PBS to rinse all empty bottles one by one and add the rinse 
material to the tubes. Keep all centrifuge tubes for the same filter in a single 
Styrofoam stand or rack. At this point, if needed, samples can be stored at 4oC 
overnight before continuing the procedure. 

E. Centrifuge the 50 mL (or 15 mL) centrifuge tubes at 4,000 x g for 45 min.  
F. After the centrifugation, aspirate all but ~1 mL of the supernatant from each 

of the 50 mL tubes to waste without disturbing the pellets. If using multiple 
tubes, you need to combine multiples pellets into one 15 mL tube and proceed 
with an extra centrifugation (4000 x g for 45 min) to obtain a final pellet. 

G. At this point, the content of each ultrafilter is contained in one tube. Label 
appropriately. 

H. Store the pellets at 4°C for no more than 24 h.  
I. Autoclave the supernatant waste. 

 
DNA Isolation and Purification 
 
Modified DNA Isolation Protocol Using the FastDNA® SPIN Kit for Soil  

i.            Material preparation: 
a. Add 100 mL of 100% ethanol to the 12 mL concentrated 

SEWS-M wash solution when a new kit is opened. 
b. Fill up an ice bucket for cooling the samples after the FastPrep-

24 bead beater homogenizing steps (Step vi and vii below). 
c. Set a heat block for 2.0 mL tubes to 55°C. 
d. Label the DNase-free 2.0 mL tubes appropriately. These are 

the tubes to be used in step ix and are NOT provided in the kit. 
e. Program the FastPrep-24 bead beater to a setting of 6.5 m/s 

(corresponds to approximately 4000 rpm) for 60 s. 
ii. Assemble the sample pellets in the 50 mL or 15 mL tubes for DNA 

isolation on a workbench cleaned with DNA AWAY or a cleaned Bio-
Safety Cabinet (BSC). Include a Lysing Matrix E (LME) tube 
(supplied with the FastDNA Spin Kit) for the negative DNA 
extraction control. 

iii. Add 830 µL Sodium Phosphate Buffer (SPB) to the mixture in the 50 
mL (or 15 mL) conical tubes (and to the DNA extraction control LME 
tube). Mix each of the pellets in the 50 mL (or 15 mL) conical tubes 
with the buffers using a sterile wooden stick or a sterile transfer 
pipette. Try to minimize generating bubbles. 

iv. Carefully transfer the mixture (pellet, MT and SPB buffers) from each 
50 mL (or 15 mL) conical tube into an LME tube using a sterile 
transfer pipette. Make sure that there is at least 1.0 cm of air space at 
the top of the tube to allow for efficient bead-beating; do not fill 
beyond the maximum fill height as shown in Figure 4. If the total 
volume is too large, split the mixture into extra LME tubes. The 
sample can be recombined later as described in step xv. 

v. Add 122 µL MT buffer to each of the LME tubes containing pellets. 
Screw the caps on securely.  
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Figure 4. Maximum fill height for LME tubes. 

vi. Transfer the samples to the FastPrep-24 bead beater, making sure to 
balance and secure the tubes in the sample holder according to the 
manufacturer’s instructions. Homogenize at a setting of 6.5 m/s for 60 
s. Immediately remove the sample holder containing the tubes from 
the instrument and place on ice for 3 mins.  

vii. Return the sample holder to the bead beater and repeat the 
homogenization and the incubation on ice as above for 3 min.  

viii. Remove the tubes from the sample holder and centrifuge at 14,000 x g 
for 15 min (FastDNA kit protocol step 5).  

ix. Transfer the supernatant to a clean 2 mL tube (use the 2 mL tubes 
indicated in step 3.4.A.i.d which are NOT included in the kit). Add 
250 µL PPS solution and mix by inverting by hand 10 times 
(FastDNA kit protocol step 6).  

x. Centrifuge at 14,000 x g for 5 min (FastDNA kit protocol step 7).  
xi. During the above centrifugation, re-suspend the Binding Matrix 

provided in the kit by shaking well before use. Transfer 1.0 mL of re-
suspended Binding Matrix to a clean 15 mL conical tube for each 
sample. (For easy pipetting, 5 mL tubes may be used for this step 
instead of 15 mL tubes). 

xii. Transfer the supernatant from each sample to a tube containing 1.0 mL 
of re-suspended Binding Matrix.  

xiii. Place the tubes in a rack and mix by inverting the rack for 2 min and 
then allow the silica matrix to settle for 3 min (FastDNA kit step 9). 
Centrifuge the tubes briefly at 1000 x g for 1 min in a centrifuge 
(using a swinging bucket rotor).  

xiv. Remove 1.4 mL (700 µL x 2) of the supernatant from each tube by 
pipetting.  

xv. Re-suspend the matrix in the remaining supernatant (with a pipette) 
and transfer all of the volume to a SPIN Filter in a catch tube provided 
in the kit. Centrifuge at 14,000 x g for 1 min (FastDNA kit protocol 
step 11). If a sample was split into two or more tubes at step v above, 
transfer the matrix from the first tube to one spin filter and perform 
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the centrifugation.  Then, discard the flow through and transfer the 
matrix from the second tube to the same spin filter and perform 
another centrifugation. 

xvi. Add 500 µL prepared SEWS-M to each filter. Gently re-suspend each 
pellet by stirring (with a P-200 tip) for ~ 10 s.  Do not poke the 
membrane. (FastDNA kit protocol step 12).  

xvii. Centrifuge at 14,000 x g for 1 min. Empty the catch tube and replace 
the filter back into the same tube. (FastDNA kit protocol step 13).  
Note: if the sample is too thick and some liquid won’t go through, you 
will need to centrifuge the sample for another 1 or 2 min.   

xviii. Centrifuge at 14,000 x g for 2 min to dry the matrix. Discard the catch 
tube and replace with a new catch tube provided in the kit (FastDNA 
kit protocol step 14).  

xix. Air dry the filter for 5 min at room temperature (FastDNA kit protocol 
step 15).  

xx. Add 75 µL DES to the matrix in the spin filter. Re-suspend the 
Binding Matrix by gently stirring with a P-10 pipette tip. Do not 
puncture the membrane. Incubate the tubes at 55°C in a heat block for 
5 min. (FastDNA kit protocol step 16).  

xxi. Centrifuge at 14,000 x g for 1 min to recover the eluted DNA and 
discard the SPIN Filter (FastDNA kit protocol step 17).  

xxii. Proceed to DNA purification.  
 
DNA Purification Using the QIAquick® PCR Purification Kit  
 

i. Upon opening a new kit:  
a.  Add 96-100% ethanol to Buffer PE wash solution (see bottle 

label for ethanol volume).  
b. Add the pH indicator to Buffer PB. 

ii. Add 375 µL of Buffer PB to the DNA sample and mix. If the color of 
the mixture is orange or violet, add 10 μL 3 M sodium acetate, pH 5.2, 
and mix.  

iii. To bind DNA, apply the DNA sample to the QIAquick column and 
centrifuge at 14,000 x g for 30–60 s. Discard the flow-through and 
place the QIAquick column back in the same tube.  

iv. To wash, add 750 μl Buffer PE to the QIAquick column, centrifuge at 
14,000 x g for 30–60 s, discard the flow-through, and place the 
QIAquick column back in the same tube.  

v. Repeat step iv. 
vi. Centrifuge the QIAquick column once more for 1 min to remove 

residual wash buffer.  
vii. Place each QIAquick column in a clean 1.5 mL microcentrifuge tube. 

To elute DNA, add 50 μL Buffer EB (10 mM Tris·Cl, pH 8.5) to the 
center of the QIAquick membrane, let the column stand for 1 min, and 
then centrifuge at 14,000 x g for 30-60 s to elute the purified DNA.  

viii. Centrifuge the QIAquick column once more for 1 min. Discard the 
columns and cap the tubes. 
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ix. Proceed to real-time PCR detection, or you may store the DNA 
samples at 4°C for up to 2 days or at -20 or -80°C for longer term 
storage. 
 

 Cyclospora cayetanensis Real-Time PCR Detection Method  
Reagent Ordering and Preparation Instructions  
 
All Primers, Probes, and Target control DNAs are commercially synthesized by 
Integrated DNA Technologies (IDT), Coralville, IA. 
 
Primers: All primers are ordered from IDT normalized to a working concentration of 
500 µM and stored at -20°C.  
 
Primer Ordering Instructions: Choose "Custom DNA Oligos" from the applicable 
IDT online  menu page and select “DNA Oligos”. From the "Normalization" drop 
down menu → choose "Create a custom formulation" → choose "Full product yield, 
to a specified µMolar concentration" → enter "500" and choose "IDTE 8.0 pH" → 
Name the normalization "500 µM" and Save. Next, on the Oligo Entry page enter the 
primer options as indicated below for each primer:  

 
Table 1-1. Primer Ordering Instructions. 

Scale:  choose a scale between 25 nmole and 1 µmole  
Normalization:  500 µM  
Purification:  Standard Desalting  

 
Table 1-2. Primer Names and Sequences. 

   Item Name Sequence 
Forward primer for 
amplification of  
the mitochondrial C. 
cayetanensis target  

Mit1C-f  5'-TCTATTTTCACCATTCTTGCTCAC-3'  
  

Reverse primer for 
amplification of  
the mitochondrial C. 
cayetanensis target  

Mit1C-r  5'-TGGACTTACTAGGGTGGAGTCT-3'  
  

Forward primer for 
amplification of  
the IAC target  

dd-IAC-f  5'-CTAACCTTCGTGATGAGCAATCG-3'  
  

Reverse primer for 
amplification of  
the IAC target  

dd-IAC-r  5'-GATCAGCTACGTGAGGTCCTAC-3’  
  

 
Probes: Taqman-style hydrolysis probes are used for detection of the C. 
cayetanensis and IAC targets. The C. cayetanensis probe is labeled with 5’ FAM 
reporter dye and is double quenched with an internal ZEN quencher and 3’ Iowa 
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Black® FQ (IABkFQ) quencher. The IAC probe is labeled with 5’ Cy5 reporter dye 
and is double quenched with an internal TAO quencher and 3’ Iowa Black® RQ-Sp 
(IAbRQSp) quencher. Probes are ordered from IDT and hydrated to working 
concentrations as described below and stored at -20°C.  
 
Probe Ordering Instructions: Probes are ordered from the applicable IDT online  
menu page by choosing "Custom probes" → choose PrimeTime qPCR Probes → 
choose 250 nmol or 1 µmol scale. Enter probe nucleotide sequence and choose "5’ 
Dye/3’ Quencher" options as indicated for each probe in Table 1-3. (No "Services" 
options are required.)  

 

Table 1-3. Probe Ordering Information. 

   Probe for detection of  
C. cayetanensis target 

Probe for detection of  
IAC target 

Item Name   Mit1P-FAM  dd-IAC-Cy5  
Sequence  5'-

AGGAGATAGAATGCTG
GTGTATGCACC -3'  
  

5'-
AGCTAGTCGATGCACTCCAGT
CCTCCT-3'  
  

5' Code  /56-FAM/  /Cy5/  
3' Quencher  ZEN-3’ Iowa Black® FQ   TAO-3' Iowa Black® RQ-Sp  
3' Code  /3IABkFQ/  /3IAbRQSp/  

 
Preparation of Probe Working Solutions:  
100 µM Mit1P-FAM: Hydrate the lyophilized probe in sterile DNase-free TE buffer by 
adding the volume specified on the accompanying IDT probe specification sheet for a 100 
µM final concentration. Vortex and centrifuge the hydrated probe briefly. 
 
100 µM dd-IAC-Cy5: Hydrate the lyophilized probe in sterile DNase-free TE buffer by 
adding the volume specified on the accompanying IDT probe specification sheet for a 100 
µM final concentration. Vortex and centrifuge the hydrated probe briefly. 
  
IAC Target: The IAC reaction target (HMultra130-synIAC) is a synthetic 200 bp ultramer 
DNA sequence based on the internal amplification control developed by Deer et al., (2010). 
 
Ordering Instructions: From the applicable IDT online menu page choose "Ultramer 
Oligos (up to 200 bases)" → On the Oligo Entry page enter or choose the following: 
 

Table 1-4. Ultramer Oligo Description. 

Item Name: HMultra130-synIAC 
Scale:  4 nmole Ultramer™ DNA Oligo 
Normalization: None 
Purification: Standard Desalting 
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TACAGCACCCTAGCTTGGTAGAATCGATCAGCTACGTGAGGTCCTACGACGATC
GCCAAGCATGCCCTAGCTAAGATGCATCGATTGCTCATCACGTACGTTAGGTCG
ACTAGGAGGACTGGAGTGCATCGACTAGCTAAGATGGTTCGATTGCTCATCACG
AAGGTTAGGTCGACTACGAACGAGTCGTATTGCAGGTT  
 
Preparation of IAC Target Working Solution: Hydrate the ultramer and prepare dilutions 
in TE pH 7.5 dilution buffer according to Appendix 3 to obtain the working concentration of 
1E7 copies/µL. Store dilutions at -20°C. 
 
Positive Control: The positive control DNA (Mit1AA gblock) is a 245 bp double stranded 
synthetic gBlocks® Gene Fragment synthesized by IDT. The sequence corresponds to a 
region (4325 bp - 4569 bp, Genbank: KP231180.1) in the C. cayetanensis Mitochondrial 
gene. In addition, this sequence contains traceable mutations (T4385A and T4386A) within 
the amplicon generated by the real-time PCR primers used in this protocol. 
  
Ordering Instructions: From the applicable IDT online menu page choose “Double 
Stranded DNA Fragments” and select gBlocks Gene Fragments. Enter the following item 
name and sequence on the gBlocks Gene Fragments Entry page:  
 
Item Name: Mit1AA gblock  
 
Sequence:  
ACAGTTGGTTTTCTATTTTCACCATTCTTGCTCACTGTATTAGTATTATTTAATTTT
ACTAATAGAGAAGTTGGTACTACATCAGCTTCTCTGGTTTCATCAATTTGTTTAG
GTGTTATTAGTACTGAGTTACTACTATTTGTTAGCTTCTTCTGGGGTGCATACACC
AGCATTCTATCTCCTAGTTATGTAACAGACTCCACCCTAGTAAGTCCAACTGAGG
GTCTTGTAAGTATCTCTAGTAG  
 
Click "Add to Order" → answer "No" to all questions on the Terms and Disclosure pop up 
window → type your name in the Signature box → accept the terms and conditions → click 
"Add to Cart". The amount delivered will be 250 ng of the gBlock. Hydrate the gBlock and 
prepare dilutions according to Appendix 4 to obtain the working solution concentration of 
5E2 copies/µL. The positive control working solution can be stored at -20 or 4°C. A fresh 
working solution should be prepared from the frozen 5E3 dilution every 90 days. 
 
Reaction Setup and Execution 
A primer/probe mix must be prepared for the C. cayetanensis target reaction and for the IAC 
target reaction. Briefly mix and centrifuge all reagents to resuspend and bring down contents 
before assembling mixes. 
 
Primer/Probe Mixes (store at -20°C in dark):  
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Table 1-5. 20X Mit1C Pr/Pro (12 µM each primer, 6 µM probe). 

  Volume Final concentration 
12.0 µL 500 µM Mit1C-f  0.6 µM final in reaction  
12.0 µL 500 µM Mit1C-r  0.6 µM final in reaction  
30.0 µL 100 µM Mit1P-
FAM  

0.3 µM final in reaction  

446 µL TE    
500 µL final volume    

   
Table 1-6. 20X synIAC Pr/Pro (5 µM each primer, 5 µM probe, 2E5 copies synIAC target). 

Volume  Final Concentration 
5.0 µL 500 µM dd-IAC-f  0.25 µM final in reaction    
5.0 µL 500 µM dd-IAC-r  0.25 µM final in reaction  
25.0 µL 100 µM dd-IAC-Cy5  0.25 µM final in reaction  
10 µL 1E7 copies/µL HMultra130-
synIAC  

1E4 copies/µL final in reaction 

455 µL TE     
500 µL final volume     

 
Real-Time PCR reaction mix for 20 µL volume reactions:  
 
All samples and all controls are always run in triplicate.  
Briefly mix and centrifuge all reagents to resuspend and bring down contents before 
assembling reaction mix. The master mix formula below is sufficient to run one (1) replicate 
of one sample. For each qPCR experimental run, prepare sufficient reaction mix to run the no 
template control (NTC), the positive control, and samples all in triplicate. Calculate the total 
number of replicates being run (N) in one experiment and prepare a volume of master mix 
between N+1 and N+3 to assure sufficient reagents for all replicates.  

 
Table 1-7. Reaction mix for 20 µL volume reactions. 

Master mix components 10.0  µL 2X PrimeTimeTM Gene Expression 
Master Mix low ROX (IDT) 

Master mix components 1.0  µL 20X Mit1C Pr/Pro Mix  
Master mix components 1.0  µL 20X synIAC Pr/Pro Mix  
Master mix components 6.0  µL H2O (DNase-free)  
Sample 2.0  µL sample or control  
Total Volume 20.0  µL total volume  

 
Aliquot 18 µL of reaction mix to each reaction well or tube.  
Add 2.0 µL of sample or appropriate controls to each reaction plate well or tube (see 
Section C below).  
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Samples and Controls:  
Table 1-8. Sample and Controls volume 

NTC  2.0 µL H2O (DNase-free)  
DNA extraction 
control  

2.0 µL  

Samples  2.0 µL (1X and 1/10 dilution)  
Positive Control  2.0 µL Mit1AA gBlock (5E2 

copies/µL)  
 
Always briefly vortex and centrifuge controls and samples before adding to reaction wells or 
tubes.  
 
ALL SAMPLES ARE TO BE ANALYZED AT 1X AND A 1/10 DILUTION IN THE SAME 
INITIAL EXPERIMENTAL RUN (Controls are not tested at a 1/10 dilution). Prepare diluted 
samples following instructions below. 
  
1/10 Sample Dilution Protocol:  
Transfer 2 µL of sample to a clean microcentrifuge tube containing 18 µL of TE. Mix well and 
centrifuge briefly. 
  
After addition of samples and controls to reaction wells or tubes, seal the plate with the 
adhesive film or seal the tube strips with cap strips and centrifuge at 400 × g for 30 s.  
 
Run the plate or tube strips in the ABI 7500 Fast Real-Time PCR Instrument using a pre-defined 
protocol template and run method as described below. 
  
Real-Time PCR Cycling Protocol Templates for the ABI 7500 Fast Instrument:  
Prior to initiating a run each laboratory should define a protocol template as described in Appendix 5 
for ABI Fast instruments running v2.0 or 2.3 software or Appendix 6 for instruments running v1.4 
software. 
  
Run Methods on the ABI 7500 Fast Instrument:  
Cycling Parameters. 
Follow the run method detailed in Appendix 5 for ABI Fast instruments running v2.0 or 2.3 software 
or Appendix 6 for instruments running v1.4 (or any v1.x) software:  
 

• Set-up the program in the instrument with an initial step of 95 °C for 3 min followed by 40 
cycles of [95 °C for 15 sec + 67 °C for 60 sec]. Data collection should be on during the 67°C 
step. 

 
The following software analysis settings are applied to data when instructions for protocol templates 
and run methods in Appendices 5 or 6 are followed:  

• Manual Threshold = 0.05 (C. cayetanensis target; Mit1C)  
• Manual Threshold = 0.05 (IAC target)  
• Auto Baseline  
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Document the experimental run by saving the run file and an exported results data file according to 
the instructions in Appendix 5 or 6. Print the exported results data file and include with analytical 
worksheet packet. 
 
Interpretation of Results 
Positive Samples:  

• Samples are only considered positive for the presence of C. cayetanensis if, on initial testing 
or re-testing, one (1) or more sample replicates produces a smooth exponential/sigmoidal 
amplification signal with Ct ≤ 38.0 for the C. cayetanensis mitochondrial target (Mit1C) 
reaction and the IAC target reaction is either Negative or Positive.  

• ONLY ONE REPLICATE OF AN UNKNOWN SAMPLE OR 1/10 DILUTION OF 
THAT SAMPLE NEEDS TO BE POSITIVE FOR THE C. cayetanensis Mit1C 
TARGET IN ORDER TO CONSIDER A SAMPLE POSITIVE.  

 
Samples for Further Analysis:  

• Any sample producing a smooth exponential/sigmoidal amplification signal in one (1) or 
more replicates for the C. cayetanensis Mit1C target reaction crossing the threshold with 
Ct(s) > 38.0 and the IAC target reaction is either Negative or Positive: Consult CFSAN 
SME (depending on the SME advice the sample might need to be re-tested one time (in 
triplicate) at both 1X and 1/10 dilution).  

 
Negative Samples:  

• If a sample C. cayetanensis Mit1C target reaction produces all replicates with undetermined 
Ct and sample IAC target reaction produces an average Ct value that is not more than 3 
cycles higher compared to the NTC (no template control): Sample is NEGATIVE, no 
further action. 

 
Invalid Results:  

• If one (1) or more replicates of the NTC sample or the DNA extraction control sample Mit1C 
target reactions produces a positive result crossing the threshold, the experimental run is 
invalid and must be repeated.  

 
• If after repeat of an invalid experimental run, the DNA extraction control repeatedly 

produces a positive result and the NTC sample is negative, the DNA extraction procedure 
was likely contaminated. The DNA extraction procedure must be repeated for the entire set 
of samples if available.  

 
• If one (1) or more replicates of the positive control sample for C. cayetanensis Mit1C is 

undetermined, the experimental run is invalid and must be repeated. 
 
Inconclusive Results:  

• If on the initial test (or after re-test if required), a sample produces no replicate with Ct ≤ 
38.0 (for C. cayetanensis mitochondrial Mit1C target), and sample IAC target is 
undetermined or produces an average Ct value more than 3 cycles higher compared to the 
NTC: Sample is INCONCLUSIVE → consult CFSAN SME 
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2. Appendix 1. Sanitizing Polypropylene (PP) Carboys and Centrifuge mL Bottles 
 

Procedure: 
A. Spray a liberal amount of a 0.65% bleach solution into the carboy/bottle. Add 

water to create approximately a 1:1 by volume bleach/water mixture at the 
bottom of the carboy/bottle. 

B. Screw the cap of the carboy/bottle back on and gently shake the carboy/bottle, 
ensuring that the bleach/water mixture rinses the entire inside of the 
carboy/bottle and cap.  

C. If you are cleaning a centrifuge bottle, brush the bottle with a tube brush to 
remove any residual pellet material. 

D. Dispose of the bleach/water mixture into a waste container carefully. Leave 
the carboy/bottle to air dry for approximately two hours. The carboy/bottle 
does not need to be completely dry for the next step.   

E. Rinse the carboy/bottle with DI water once to remove residual bleach. Discard 
the liquid into the waste container. 

F. Autoclave the carboy/bottle at 121oC, 15 psi for approximately 20 min. 
 
 
3. Appendix 2. Tris EDTA (TE) pH 7.5 buffer (10mM Tris, 0.1mM EDTA, pH 8.0). 
 
Table 3-1. Tris EDTA components 

Reagent Volume 
1 M Tris pH 7.5 100 µL 
0.05M EDTA 20 µL 
PCR-grade water (Dnase/Rnase free) 9.88 mL 
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4. Appendix 3. Preparation of the Internal Amplification Control (IAC) Target Working 
Solution. 

 
Hydrate the IAC Target ultramer (HMultra130-synIAC) in TE pH 7.5 dilution buffer according to 
instructions below to obtain the working concentration of 1E7 copies/µL. Store dilutions and 
working solution at -20°C. 
 
Table 4.1. Internal Amplification Control (IAC) Target Working Solution 

HMultra130-synIAC IAC Target: Hydration and Dilution 
Procedure 

Concentration 
(copies/µL) 

Centrifuge the lyophilized ultramer (4 nmoles) prior to opening to 
ensure the contents are in the bottom of the tube. Hydrate in 
original tube with 1000 µL TE dilution buffer and vortex briefly. 
Centrifuge again to bring liquid contents to the bottom of the 
tube. 

5E12* 

Mix 10 µL of the 5E12 stock + 990 µL TE in a new tube. 
Centrifuge to bring liquid contents to the bottom of the tube. 5E10 

Mix 10 µL of the 5E10 stock + 990 µL TE in a new tube. 
Centrifuge to bring liquid contents to the bottom of the tube. 5E8 

Mix 10 µL of the 5E8 stock + 490 µL TE in a new tube. 
Centrifuge to bring liquid contents to the bottom of the tube. 1E7 

*Note: This value is theoretically derived and is a function of the DNA concentration, Avogadro’s 
number, length of template, and average weight of a basepair. There are freely available online 
calculators to derive this value. 

 
Step 1: Convert 4 nmol to µg DNA using a molar quantity to weight calculator for nucleic 
acids. The derived weight is 519.2 µg. 
 
Step 2: Use the calculated DNA weight (519.2 µg) and the molecular weight of the sequence 
(61882) to compute the copy number. This will be approximately 5.138E15 copies (using 
650 Da as the mass of a DNA base pair). Since the lyophilized target is dissolved in 1000 µL 
TE, the approximate copies is 5E12 copies/µL. 
 

• An optional method for an accurate measurement is to determine the concentration of DNA 
(above- lyophilized target in 1000 µL TE) using preferably a high sensitivity Qubit kit or 
nanodrop. The concentration (ng/µL) can be plugged into a copy number calculator to derive 
an accurate copies/µL of the target which can then be diluted to achieve 1.0E6 copies/µL.  
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5. Appendix 4. Preparation of the Positive Control Target Working Solution. 
Hydrate and dilute the Positive Control gBlock (Mit1AA) in TE pH 7.5 dilution buffer according to 
instructions below to obtain the working concentration of 5E2 copies/µL. Store dilutions at -20°C. 
The working solution can be stored at -20 or 4°C. A fresh working solution should be prepared 
from the frozen 5E3 dilution every 90 days. 
 
Table 5.1.  Positive Control Target Working Solution 

Mit1AA Positive Control: Hydration and Dilution Procedure Concentration 
(copies/µL) 

Centrifuge the lyophilized gBlock (250 ngrams) prior to opening. 
Hydrate in original tube with 500 µL TE dilution buffer. Vortex briefly 
and incubate at 50°C for 20 minutes. Vortex briefly and centrifuge again 
to bring liquid contents to the bottom of the tube. 

2E9 

Mix 10 µL of the 2E9 stock + 990 µL TE in a new tube. Centrifuge to 
bring liquid contents to the bottom of the tube. 2E7 

Mix 10 µL of the 2E7 dilution + 990 µL TE in a new tube. Centrifuge to 
bring liquid contents to the bottom of the tube. 2E5 

Mix 10 µL of the 2E5 dilution + 390 µL TE in a new tube. Centrifuge to 
bring liquid contents to the bottom of the tube. 5E3 

Mix 50 µL of the 5E3 dilution + 450 µL TE in a new tube. Centrifuge to 
bring liquid contents to the bottom of the tube. 5E2 

• Note: This value is theoretically derived and is a function of the DNA concentration, 
Avogadro’s number, length of template, and average weight of a basepair. There are freely 
available online calculators to derive this value. 
 
Step 1: Use the DNA amount (250 ng) and the molecular weight of the sequence (151227.2) 
to compute the copy number. This will be approximately E12 copies (using 650 Da as the 
mass of a DNA base pair). Since the lyophilized target is dissolved in 500 µL TE, the 
approximate copies are 2E9 copies/µL. 
 

• An optional method for an accurate measurement is to determine the concentration of DNA 
(above- lyophilized target in 500 µL TE) using preferably a high sensitivity Qubit kit or 
nanodrop. The concentration (ng/µL) can be plugged into a copy number calculator to derive 
an accurate copies/µL of the target which can then be diluted to achieve 5E2 copies/µL. 
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6. Appendix 5. ABI 7500 Fast v2.0 or 2.3 Method 
 

Define a Run Template Using Software v2.0 or 2.3 on the ABI 7500 Fast Instrument: 
Turn on the computer and ABI 7500 FAST Real-Time PCR system. Open the 7500 
Software v2.0 or 2.3 and click “New Experiment” (Advanced Setup). Define 
“Experimental Properties” as shown below with “Experiment Name” “Cyclospora 
cayetanensis” 

 
 
 

Click “Plate Setup” on left. Add targets to the “Define Targets and Samples” tab as shown 
below. Define the targets Mit1C as “FAM” and IAC as “CY5” with quencher set as 
“None”. 
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Click “Run Method” on left and define cycling parameters as shown below for a 20 µL 
reaction. Define the program with an initial step of 95°C for 3 min followed by 40 cycles 
of [95°C for 15 sec + 67°C for 1 min]. Data collection should be on during the 67°C hold. 
 

 
 
 

Choose “Analysis” on the left and click “Analysis Settings” in the upper right corner. 
Define target Ct settings in the pop up window: 
(A) Select the Mit1C target: Turn off: “Use Default Settings” and “Automatic 

Threshold”. Set the Threshold to 0.05 and choose “Auto Baseline”. 
(B) Select the IAC target: Turn off: “Use Default Settings” and “Automatic 

Threshold”. Set the Threshold to 0.05 and choose “Auto Baseline”. 
(C) Click “Apply Analysis Settings”. 
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Click “File”  “Save as template…”  “Save” 

 
 
Run Method Using Software v2.0 or 2.3 on the ABI 7500 Fast Instrument 
 
Click “File”“New Experiment””From Template”. Choose the “Cyclospora 
cayetanensis.edt” template file created according to Appendix 2 instructions above. Under 
“Setup” on the left click “Plate Setup” and define all unknown samples or DNA extraction 
controls on the plate on the “Define Targets and Samples” tab by clicking “Add New 
Sample” until all samples are defined. 
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Click the “Assign Targets and Samples” tab to define well assignments. Define the NTC 
wells by selecting three wells and checking the box next to the Mit1C target choosing “N” 
as task. Also, assign the internal amplification control by selecting all reaction wells and 
checking the box next to the IAC target choosing “U” as task. Confirm that ROX is 
selected as a passive reference dye. 

 
 
Define all unknown samples or DNA extraction controls one at a time by selecting three 
wells for each and checking the box next to the sample name in the “Assign sample(s) to 
the selected wells” panel. 
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Then select all unknown samples or DNA extraction controls and check the box next to 
Mit1C and IAC targets choosing “U” as task. 
 

 
 
Define the Positive control (Standard) wells by selecting three wells and checking the box 
next to the Mit1C target choosing “S” as task and “1000” as quantity. “File””Save as” 
Experiment Document Single file (*.eds) with a unique name. Insert plate or tube strips 
and start the run. 
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Analysis Using Software v2.0 or 2.3 on the ABI 7500 Fast Instrument 
 
When the run is complete select “Amplification Plot” under “Analysis” on the left. Ensure 
that all wells are selected on the “View Plate Layout” tab to the right of the amplification 
curves. In the options panel below the amplification curves, select the “IAC” target and 
check that the show threshold and baseline boxes are both checked. Verify threshold and 
baseline settings are accurate as defined in the run template above. 
 

 
 
 

Next, select the “Mit1C” target in the options panel and check that the show threshold and 
baseline boxes are checked. Verify threshold and baseline settings are accurate as defined 
in the run template above. 
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Review the amplification plots and Ct’s for each target. Verify that all criteria for a valid 
experimental run are met as defined in the “Interpretation of Results” section of the 
protocol. 
 
Then, assure that all reaction wells on the plate are selected by clicking the upper left corner of the 
plate layout. Click “Export” to open the Export Tool window. 
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On the “Export Properties” tab, select the following: 
 

1. Select “Results” only. 
2. Choose “One File” 
3. Name: use experiment name. Location: define a location of your choice. File type: 

choose “.xls” 
Click the “Customize Export” tab and select the following results content: Well, Sample 
Name, Target Name, Task, Reporter, Ct, Ct Mean, Ct SD. 
Click on the “Target Name” column header to sort the table by target name. Click “Start 
Export”. Close the export tool. 
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7. Appendix 6. ABI 7500 Fast v1.4 Method. 
 
Define Protocol as a Template 

 
Turn on the ABI 7500 FAST Real-Time PCR instrument and computer. Open 7500 Fast System 
Software v1.4. It shows “Quick start” →click “cancel”. From “File” → New → New Document 
Wizard (Define Document) → “Next: → “Select Detectors” → “Next” → “Set Sample Plate” → 
“Finish” → Click on the “Instrument” tab. 
 

1. Key in the following parameters: 
Stage 1: Reps:1 
 95 °C; 3:00 
Stage 2: Reps: 40 
 95 °C; 0:15 
 67 °C; 1:00 
 

2. Sample Volume (µL): 20 
Run Mode: Fast 7500 
Data collection: Stage 2, step 2 (67 °C @ 1:00) 
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Create Detectors: Mit1C & IAC (internal amplification control) 
 
Select “Tools” → “Detector Manager” → File → “New” → “Name”: MIt1C “Reporter Dye; FAM. 
“Quencher Dye”: None, “Color”: Green → OK. Click “Create Another” → File → New → “Name”: 
IAC, Reporter Dye: Cy5, “Quencher Dye”: None, “Color”: Purple → “OK”. Click “OK” on “New 
detector” window.   
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Highlight both the Mit1C and IAC detectors. Click “Add to Plate document”. Click “OK” after each 
detector is added to the plate. Click “Done” on “Detector Manager Window”. 

 
 

 
Save Protocol as a SDS Template [*sdt] in Drive D: → Applied Biosystems → 7500 system → 
templates → File Name: “Cyclospora cayetanensis”. 
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Start a new Run 
 
Turn on the ABI 7500 FAST Real-Time PCR instrument and computer. Open 7500 Fast System 
Software v1.4 
From “Quick Startup” → Click “Create New Document” to open “New Document Wizard” and 
“Define Document”. 

 
Assay: Standard Curve (Absolute Quantitation) 

 
Template: Click on “Browse” → navigate to “templates” folder → Select “Cyclospora 
cayetanensis.sdt” 

 
Plate Name: “Cyclospora Test 1” → “Finish” 
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From “View” → Select “Well inspector” to define well assignments. Define the no template control 
wells by selecting three wells and type “NTC” in the “Sample Name” field on the “Well Inspector” 
window. Check the “Mit1C” detector choosing “NTC” as “Task”. Define all unknown samples and 
DNA extraction control samples in the same manner but choose “Unknown” as “Task”. 

 
 
Define the positive control in the same manner but choose “Standard” as “Task” and enter “1000” as 
“Quantity”.  
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Assign the IAC detector to all wells by highlighting all reaction wells” Check the “IAC” detector in 
the “Well Inspector” window and choose “unknown” as “Task”. Close the “Well Inspector” 
window.   From the “File” menu → “Save” to choose a location to save the run file.  
 

 
 
Insert the plate to begin the run and click the “Instrument” tab → “Start”.  
 

 
  



Standard Operation Procedure 
Dead-end Ultrafiltration for the Detection of Cyclospora cayetanensis from Agricultural Water 

   

39  

 
Results 
 
Click on the “Results” tab → Select the “Amplification Plot” tab. Select all wells in the lower 
portion of the window. On the “Data” drop down menu on the right selection choose “Delta Rn vs. 
Cycle”, and then define Analysis Settings for each target: 
 
Select Detector “Mit1C” and Line Color “Detector Color”. In the “Analysis Settings” box select: 
 

“Manual Ct” Threshold = 0.05 
“Auto Baseline” 

 
Select Detector “IAC” and Line Color “Detector Color”. In the Analysis Settings” box select:  
 

“Manual Ct” Threshold = 0.05 
“Auto Baseline” 

 
Click “Analyze”. Save the run analysis results as an SDS Document (*SDS). 
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Click on the “Report” tab. Assure that all wells are still detected in the lower portion of the 
window. 
 
Click on the “Report” tab. Assure that all wells are still detected in the lower portion of the 
window.

 
Review the Amplification Plots and Ct’s for each target. Verify that all criteria for a valid 
experimental run are met as defined in the “Interpretation of Results” section of the protocol. 
 
Save an Experimental Results Report by clicking the “File” drop down menu → “Export” → 
“Results”. On the “Select Results Export File” window choose a location to save the results file. 
 

File name: use experiment run name. 
Save as type: Results Export File (*.cvs). 

 
 
Click “Save”. Check both options on the “Export Settings” window that appears → click “OK”. 
 


	1. Standard Operation Procedure – Dead-end Ultrafiltration for the Detection of Cyclospora cayetanensis from Agricultural Water
	1.1. Dead-end Ultrafiltration
	1.2.  Recovery and Detection of Cyclospora cayetanensis from Ultrafilters
	1.3. Cyclospora cayetanensis Real-Time PCR Detection Method

	2. Appendix 1. Sanitizing Polypropylene (PP) Carboys and Centrifuge mL Bottles
	3. Appendix 2. Tris EDTA (TE) pH 7.5 buffer (10mM Tris, 0.1mM EDTA, pH 8.0).
	4. Appendix 3. Preparation of the Internal Amplification Control (IAC) Target Working Solution.
	5.  Appendix 4. Preparation of the Positive Control Target Working Solution.
	6. Appendix 5. ABI 7500 Fast v2.0 or 2.3 Method
	7.  Appendix 6. ABI 7500 Fast v1.4 Method.

